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3. MONITORAMENTO DE CULTIVOS AGRÍCOLAS  

By: André Souza1 and Agmom Rocha2   
 
A Companhia Nacional de Abastecimento (CONAB) está presente em todas as regiões brasileiras, seguindo a 
trajetória da produção agrícola, do planejamento ao plantio e até a mesa do consumidor. A CONAB contribui para a 
decisão dos agricultores quanto ao tempo de semear, a colheita, o armazenamento e permanecerá envolvida até a 
distribuição dos produtos no mercado. As operações desempenhadas pela CONAB são coordenadas pelo Ministério 
da Agricultura, Pecuária e Abastecimento (MAPA). Por estas ações a companhia conduz estudos e estatísticas de 
preços, assim como pesquisas de custos da produção agrícola, a estimativa de semeadura e colheita de grãos, além do 
volume e da localização dos estoques públicos e privados de uma variedade de produtos. A estimativa da produção 
de etanol, e o levantamento de outras informações relevantes são também estendidos às colheitas de café e de cana 
de açúcar. 
A Faculdade de Agronomia da Universidade de Campinas (FEAGRI/UNICAMP) é muito ativa no desenvolvimento 
de projetos de pesquisa focados em soluções tecnológicas para os problemas do agronegócio brasileiro. O 
Laboratório de SIG da FEAGRI tem um papel no treinamento de profissionais altamente qualificados para atuar e 
utilizar a geoinformação como uma ferramenta para a tomada de decisões. Ele também trabalha no desenvolvimento 
de estudos, planeja e integra cursos multidisciplinares em aplicações de SIG e de sensoriamento remoto e GPS na 
agricultura, meio ambiente e outras disciplinas. 

3.1. Relevância do Tópico Escolhido  
O Brasil destaca-se como um dos maiores produtores agrícolas mundiais, com ênfase em grãos, café e 
bicombustíveis. Isto foi possível devido à avanços tecnológicos que o colocou em alta posição na classificação 
mundial. No entanto, por conta das dimensões continentais deste país, a variabilidade climática é um grande desafio à 
manutenção desta posição. Por isto, é necessária a adoção de novas técnicas, e o desenvolvimento de tecnologias e 
metodologias para melhorar o monitoramento e a previsão de colheitas.  

3.2. Objetivo da Aplicação   
Usar índices de vegetação derivados do instrumento de SPOT-VEGETATION para monitorar e identificar áreas 
agrícolas com cultivos temporários (como milho, arroz, soja, cana de açúcar) e permanentes (café), assim como 
reflorestamento.  

3.3. Metodologia  
A metodologia utilizada neste exercício para o monitoramento de cultivos, baseou-se em índices de vegetação 
derivados do instrumento de SPOT-VEGETATION e informações adicionais, tais como as regiões de 
produtividade excepcional para estes cultivos em São Paulo e Minas Gerais. Também foram incluídos os estados do 
Rio de Janeiro e Espírito Santo. A área de estudo é representada na Figura 3.1. O período para este estudo de caso 
depende da disponibilidade de dados de Produtividade de Matéria Seca (Dry Matter Productiviy, DMP) para a 
América do Sul. A dezena de início para este produto é a primeira de abril de 2010, e a série temporal termina na 
segunda dezena de 2011. Há duas dezenas faltando: a primeira de julho e a última de novembro de 2010. A série 
consiste, portanto de 27 dezenas. Além da DMP, foram também usados os Índice de Diferença Normalizada de 
Vegetação  (Normalized Difference Vegetation Índex, NDVI) e o Índice de Diferença Normalizada de Água 
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(Normalized Difference Water Índex, NDWI). Como base nestes conjuntos de dados, outros índices foram gerados 
para complementar a informação provida pelos NDVI, NDWI e DMP. São estes: Fração de Cobertura Vegetal 
(Fraction Vegetation Cover, FVC), Índice de Área Foliar (Leaf Área Índex, LAI), Índice de Espalhamento Estrutural 
(Structural Scattering Índex, SSI) e ainda um outro, que resulta da combinação dos dados de NDVI, NDWI e DMP. 
Este último serve apenas para destacar os padrões estruturais dos cultivos agrícolas neste estudo e foi denominado 
Índice de Vegetação Combinado (Combined Vegetation Índex, COMBVI). Para maiores informações sobre os 
produtos de Vegetação SPOT, o manual de usuários do VGT4Africa pode ser consultado (Bartolomé, 2006). 
 
 

 
Figure 3.4 Região selecionada  no Sudeste do Brasil  

 
O FVC foi calculado usando a equação 1, seguindo Jiménez-Munhoz et. al. (2005), veja também a tabela 3.1. O LAI 
foi calculado segundo a equação 2, seguindo Norman et. al. (2003). O SSI foi calculado com a equação 3, seguindo 
Gao et. al. (2003). Não há referências para o cálculo do COMBVI, um índice recentemente desenvolvido, para o qual 
se usa a equação 4. Este índice combina DMP, NDVI e NDWI, colocando os últimos “quase” na mesma escala que 
o DMP. A Figura 3.2 mostra a metodologia adotada. 
 

Número da Equação Equação usada 
Eq1 FVC = 1.1101 * NDVI – 0.08577 
Eq2 LAI = -2 * ln (1 - FVC) 
Eq3 SSI = 3.175 * NDVI – 0.297 
Eq4 COMBVI = DMP + 10 * NDVI + 10 * NDWI 

Tabela 3.1 Conjunto de Equações Usadas 

3.4. Coleta e Pré-processamento de dados  
Antes de iniciar o trabalho com os dados, abra o ILWIS, assegure-se de que a caixa de ferramentas GEONETCast 
esteja instalada e navegue para o seu diretório de trabalho ativo. Os passos de pré-processamento a seguir visam 
minimizar o tamanho da amostra de dados e o tempo de processamento necessário. A descrição dos vários passos 
(Capítulos 3.4.1 e 3.4.3) é dada como referência, e aplicada às séries de dados brutos de NDVI, NDWI e DMP, 
derivadas do instrumento de SPOT Vegetation. 

3.4.1. Pré-processamento, passo 1  
Precesse os dados de GEONETCast – DevCoCast, usando o menu “GNC-Toolbox” do ILWIS. O mesmo 
procedimento pode ser realizado usando rotinas de “batch looping”. Este procedimento também é descrito.  
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3.4.1.1. Importando arquivos brutos para o ILWIS, usando o menu “GLC- Toolbox” 
Simplesmente coloque todos os arquivos brutos em um diretório e especifique o caminho até este diretório usando o 
Navegador no ILWIS. Daí em diante, no “Operation- Tree” selecione “Geonetcast” e “Toolbox”. Escolha então a 
fonte dos dados, a região e, por fim, o produto desejado. Observe que você deve configurar,(“Configure”), os 
arquivos,(“Folders”) disponíveis no menu “GNC-Toolbox” e especificar corretamente o “Input Directory” e o 
“Output Directory”. Os arquivos originais do Vegetação - SPOT para a América do Sul obedecem a uma convenção 
de nomes, como: “V2KRNS10_20090101_NDVI_S-America.ZIP”. Usando o “GNC – Toolbox”, apenas o campo 
de data, “Date” precisa ser especificado segundo o formato exigido (aaaammdec). A Figura 3.3. mostra o menu 
“Toolbox” em detalhes. 
 

 
Figura 3.2 Metod.  p/ Monitoramento de produtividade de culturas usando índices do SPOT-VEGETATION 
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Figura 3.3 Menu do GNC-“Toolbox” para importar  produtos do SPOT VGT para a América Latina 

 

3.4.1.2. Importando várias imagens usando rotinas de “batch looping” 
É possível adaptar o comando de importação de grupos de arquivos do ILWIS, localizado no diretório 
“Extensions\Geonetccast\Toolbox\Toolbox_Batchroutines”, veja também a figura 3.4. Use o seu “Windows 
Explorer” para navegar nesta pasta, localizada dentro do diretório principal do ILWIS. Há numerosos lotes de 
arquivos (batch files) para importação de dados transferidos por GEONETCast para o formato ILWIS, usando  
comandos simples de MSDOS. 

Figura 3.4 O Diretório da rotina de “batch”  do  GNC-Toolbox 
 
Para obter os detalhes do formato bruto dos dados, são necessárias informações de meta-dados.  Usualmente, esta 
documentação também contém informações sobre correção – conversão de parâmetros e a geometria utilizada. Com 
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esta informação pode-se desenvolver uma rotina de importação para o propósito desejado. Veja, na Figura 3.5, um 
exemplo para importar dados gerados a partir do NDVI do Vegetação SPOT para a região da América Latina. Essa 
batch routine está adaptada à importação regular quando se usa o menu. Aqui o mapa de status é também aplicado. 
 

 
Figura 3.5 SPOT VGT NDVI arquivo batch de importação para a América Latina 

 
A medida que novos dados precisem ser importados para gerar uma série temporal dos produtos, uma nova “batch 
file” pode ser criada, como indicado na figura 3.6, usando uma rotina de loop do tipo “FOR” e “DO”. Neste 
exemplo todos os produtos com um nome de arquivo consistindo de “*V2KRNS10_*” will be taken (serão usados?) 
e o “NDVI_SPOT_Veg_import.bat” (veja a figura 3.5) será executado. Note que o caminho para a batch file a ser 
executada precisa ser corretamente definido, aqui se assume que todos os dados estão situados no mesmo diretório   
 

 
Figura 3.6 Procedimento batch For – Do loop 

 
Tendo selecionado a serie temporal de produtos brutos de NDVI de Vegetação SPOT, pode-se simplesmente 
executar a “batch routine” ‘NDVI_Start_SPOT_Veg.bat’ (figura 3.6), que por sua vez irá rodar a rotina principal de 
importação (“NDVI_SPOT_Veg_import.bat”, veja figura 3.5). Note que o ILWIS não precisa estar ativo, já que 
agora é operado a partir do “prompt” de comandos do MSDOS. Manipular assim os dados importados facilita a 
construção eficiente de uma série temporal. A Figura 3.7 mostra uma tela com a saída da rotina de importação, 
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quando esta está ativa. Os procedimentos de importação podem ser adaptados a cada conjunto de dados utilizado, 
basicamente pela configuração destas rotinas “batch” de importação.  
 

Figura 3.8 NDVI S10 Rotina de importação da  Informação de Tela  

3.4.2. Pré-processamento, passo 2  
 O próximo passo é criar uma lista de mapas contendo os arquivos importados. Do menu ILWIS, use a opção 
“Create” e selecione “Map List”. Selecione então os arquivos que serão parte da lista. 

Figura 3.8  Criando uma Lista de  MAPAS  



APPLICATION MANUAL 

19 

3.4.3. Pré-processamento, passo 3 
Para criar sub-mapas para a sua região de interesse (region of interest, ROI), a partir das listas de mapas, você deve 
preparar e selecionar a referência espacial com as suas fronteiras de ROI. A lista de mapas pode ser 
subsequentemente re-amostrada. A partir do menu principal de ILWIS vá para ‘Operations > Spatial Reference 
Operations > Raster > Resample > Resample Map’. Ao pressionar “Show”, a “Map List” será novamente 
amostrada. Note que vários métodos de re-amostragem “Resample Methods” podem ser utilizados. Aqui, método 
“Bicubic” é selecionado.  

Figure 3.8 Reamostrando uma lista de Mapas 

3.5. Cálculo dos Diversos Índices de Séries Temporais   
Estão à sua disposição os sub mapas para as séries temporais de NDVI, NDWI e DMP, assim como vários arquivos 
de polígonos indicando as ROI, áreas cobertas por água e a máscara (mask) de cultivo regionalizada para Café, Cana 
de Açúcar, Bicombustíveis e Reflorestamento. Para prosseguir você calculará os demais índices, como indicado na 
tabela 3.1. A partir do menu de ILWIS, selecione “Operations”, “Raster Operations” and “MapList Calculation”. 
Insira a formula como indicado na Figura 3.9, idêntica à equação 1, agora aplicada apenas se o valor de NDVI for 
maior do que 0. Se este não for o caso, o valor “ausência de dados” será retornado para o mapa de saída, aqui 
representado por “?”. 

Figure 3.9 Cálculo da Lista de Mapas para derivar o  FVC usando séries temporais do  NDVI  
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 Abra a recém calculada “Map List” e visualize o mapa “SPMG_FVC_1”, usando como representação 
(Representation) “fvc”. Note que este mapa representa a primeira dezena de abril de 2009! Todas as dezenas mais 
recentes receberam números seqüenciais mais altos. Mova, com o botão esquerdo do mouse pressionado, o cursor 
sobre a camada ativa do mapa. Você verá valores de “ausência de dados” representados por “?” e valores negativos 
devido ao método escolhido de re-amostragem. Para corrigir estes valores negativos uma nova lista de mapas pode 
ser calculada inserindo a equação a seguir diretamente na linha de comando do menu principal de ILWIS e 
pressionando “enter”: 
 
 SPMG_FVC_cor.mpl:=maplistcalculate("iff(@1>0,@1,?)",0,26,SPMG_FVC.mpl) 
Visualize mais uma vez a primeira dezena de abril de 2009 desta recém calculada “Map List” e verifique se os 
resultados estão corretos, note que nas “Raster Map Display Options” os valores mínimos e máximos do mapa 
também são fornecidos! Calcule de maneira similar também os outros índices (equações 2 a 4, como indicado na 
tabela 3.1) e verifique os seus resultados. Corrija o mapa SSI de maneira idêntica à descrita acima. Visualize o mapa 
LAI calculado usando “Representation” “lai”, e os de SSI e COMBVI usando “Representation” “Pseudo” 
 

SPMG_LAI.mpl:=maplistcalculate("iff(@1>0,-2*ln(1-@1),?)",0,26,SPMG_FVC_cor.mpl) 
SPMG_SSI.mpl:=maplistcalculate("iff(@1>0,3.175*@1-0.297,?)",0,26,SPMG_NDVI.mpl) 
SPMG_COMBVI.mpl:=maplistcalculate("@1+10*@2+10*@3",0,26,SPMG_DMP.mpl, 
SPMG_NDVI.mpl,SPMG_NDWI.mpl) 

3.6. Dados locais / regionais (in-situ) 
O Sudeste do Brasil foi selecionado para ser monitorado usando dados (NDVI, NDWI e DMP) e índices derivados 
(FVC, LAI, SSI e COMBVI). Localizações regionalizadas de cultivos são também fornecidas para a região (figura 
3.10). 
 

 
Figura 3.10 Dados locais de áreas com cana de açúcar, café, biocombustíveis, e reflorestamento  nos 

Estados de São Paulo, Minas Gerais, Rio de Janeiro e Espírito Santo, Sudoeste do Brazil 
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As áreas de cultivo de café estão baseadas em dados obtidos do Instituto Brasileiro de Geografia e Estatística 
(IBGE). As designadas como de cultivo de cana estão definidas como uma zona de proteção (buffer) ao redor das 
instalações de processamento de cana, tendo um raio mínimo de 30km. A localização das unidades de processamento 
são georeferenciadas pela CONAB. Estas áreas de proteção (buffer) abrangem a maior parte do cultivo de cana da 
região. O mesmo procedimento foi aplicado para criar zonas de proteção (buffer) para os bicombustíveis. Para 
identificar áreas de reflorestamento foram empregadas técnicas estatísticas, como o desvio padrão, usando dados de 
NDVI de SPOT-Vegetation. Em torno das áreas identificadas foram também criadas zonas de “buffer”. 
Visualize em uma nova janela o campo vetorial “G__Data_Shapes_Geoweb_BR_Graos_DevCoCast_SEBR”, 
mostrando as fronteiras administrativas. Selecione no menu da janela do mapa ativo as opções “Layers” e “Add 
Layer”, e selecione a camada “DevCoCast_SEBR_Waters”, como opções de visualização, ative “Boundaries Only” e 
pressione “OK”. Agora, selecione do menu principal da janela ativa de mapa “File” e “Open Pixel Information”. 
Arraste o curso sobre o mapa e note que a informação tabular é apresentada também. Feche a janela de “Pixel 
Information”. Agora adicione os vetores de “Bio Fuel”, “Reforestation”, “Coffee” e “Sugarcane”, usando a opção de 
visualização “boundary only”, aplicando uma “Boundary Color” diferente aos vários campos de vetores. Os seus 
resultados devem assemelhar-se aos da figura 3.10. 

3.7. Combinando dados “insitu” com os de GEONETCast – DevCoCast 
As series temporais, processadas e reamostradas, de índices do SPOT-Vegetation (NDVI, NDWI, DMP, FVC, LAI, 
SSI and COMBVI) para a região de interesse podem agora seguir sendo analisadas com o uso das máscaras de 
cultivo fornecidas, e perfis temporais das áreas agrícolas podem ser gerados para identificar o comportamento dos 
cultivos devido à variação climática e à sua influência. 
Abra a “maplist” “SPMG_NDVI” e visualize o mapa “SPMG_NDVI_1”. Adicione a este mapa a camada de vetores 
contendo as localizações das áreas de café, chamada “F_Vectors_DevCoCast_RegProdCoffee” e use a opção 
“Boundaries” apenas para a exibição desta camada. A partir do menu principal do ILWIS, selecione “Operations > 
Statistics > MapList > MapList Graph”. Na janela gráfica do “maplist” selecione como “MapList” “SPMG_NDVI”, 
use um “fix stretch” de 0 a 1, ative as opções “Continuous” e “Always on top”. Ative a janela do mapa mostrando a 
camada aberta anteriormente “SPMG_NDVI”, e amplie o canto sudoeste do mapa, veja também a figura 3.11. Passe 
o cursor do mouse, com o botão esquerdo pressionado, sobre o mapa, e tente localizar o pixel da linha 769 e coluna 
223. Note a série temporal de NDVI na janela gráfica. 
 

Figura 3.11 Mapa de NDVI com máscara de café e gráfico de séries temporais de um pixel 
 
Deselecione a opção “Continuous” e selecione o pixel situado na linha 769 e coluna 223. Escolha a opção 
“Clipboard Copy”. Do menu principal do ILWIS selecione “File > Create > Table”, como nome da tabela digite 
“Coffee” e especifique que há “27” registros, pressione OK para criar a tabela. 
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A partir do menu da tabela, selecione “Colums > Add Column”, como “Column Name” especifique “NDVI” e para 
“Precision”, escolha 4 casas decimais digitando “0.0001”.  Clique no cabeçalho de coluna “NDVI”, a coluna toda 
agora fica azul, cole os dados guardados na área de transferência para esta coluna. Crie também um algumas outras 
colunas, chamando-se de “DMP”, “NDWI”, “FVC_cor”, “LAI”, “SSI_cor” e “COMBVI” respectivamente, usando 
o mesmo número de casas decimais. Na janela de “Maplist Graph”, mude o “Maplist” para “SPMG_DMP”, 
deselecione a opção “Fix Stretch” e pressione a opção “Clipboard Copy”, cole os dados na tabela “Coffee”, sob a 
coluna “DMP”. Repita este procedimento até que as colunas tenham sido preenchidas com as séries de dados 
apropriadas. Os seus resultados devem assemelhar-se à tabela dada na Figura 3.12. Note que, no menu “Table”, a 
opção “View”, “Statistics Pane” pode ser ativada para obter um resumo estatístico das respectivas colunas. 
 

Figura 3.12 A Tabela resultante para o café contendo os valores de índices das séries temporais 
 
Pressione o ícone Graph icon no menu Table, deselecione o Eixo-X e, como eixo – Y selecione a coluna “ndvi”, 
pressione “OK”. No menu de gráfico à esquerda, deselecione a opção “Legend”. Clique duas vezes no item “ndvi” e, 
do menu “Graph Options – Graph from Columns”, selecione a opção “Line” e pressione “OK”, clique duas vezes 
em “Y-Axis left”, modifique o texto para: “ndvi, dnwi, fvc_cor, lai, and ssi_cor”, modifique a escala “Min-Max” de -
1 para 4 e especifique o intervalo como 1, “Interval”:1, pressione “OK”. Clique duas vezes também em “Y-axis 
right”, modifique o texto para: “dmp and combvi”, mude a escala de “Min-Max” de 0 para 150 e especifique 
“Interval”:50. Ative o botão “Show Axis” e deselecione a opção “Show Grid”, pressione “OK”. Clique duas vezes 
no texto “ndvi” no topo do gráfico para especificar como “Graph Title”: “Coffee time series index response 
[location row-col 769,223]”.  
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Do menu “Graph”: selecione “Edit > Add Graph > From Columns”, selecione então: “dmp” e pressione “OK” 
para adicionar esta coluna. Clique duas vezes no item “dmp” na legenda da esquerda do menu do gráfico, mude para 
a opção de representação com linha e use a cor preta. Agora “Use Y-Axis” “Right” para definir a escala, note 
também na tabela que o intervalo de valores dos dados é completamente diferente para o dmp e o cmbvi. Pressione 
OK para ver a nova série temporal de dmp no gráfico. Repita este procedimento até que todas as colunas tenham 
sido adicionadas, mude o eixo do combvi para eixo-Y à direita; para os outros, um eixo-Y à esquerda pode ser usado. 
O seu gráfico resultante deve assemelhar-se ao gráfico no topo à esquerda da figura 3.13.   
Repita o procedimento descrito acima e prepare uma tabela e um gráfico para cana de açúcar (pixel linha – col 381, 
1414), bio combustíveis (pixel linha – col 127, 1063) e reflorestamento (pixel linha – col 227, 1155). Você pode 
copiar a já criada tabela do café, para uma nova tabela chamada cana de açúcar “sugarcane”, selecionando a tabela 
“coffee” (clique sobre ela uma vez usando o botão esquerdo do mouse, e do menu principal ILWIS selecione “Edit 
> Copy Object to” e selecione a opção “New Name”, neste caso use como nome “Sugarcane”). Abra a tabela 
“sugarcane” e os dados podem ser coladas da área de transferência para as várias colunas.  

Figure 3.14 Gráficos de Séries Temporais de canade açúcar , bio combustível, e reflorestamento  
 
Fica claro que os cultivos selecionados e o reflorestamento têm diferentes respostas temporais quando se usam os 
vários índices. Deve-se perceber que há notórios picos e baixas (dips) vales? nas séries temporais, que podem exigir 
passos adicionais de filtragem, já que esta resposta poderia estar relacionada ao pré-processamento dos dados. Pode-
se então prosseguir na análise dos gráficos, isto deve ser feito com um bom conhecimento do calendário dos cultivos 
e a resposta normal (média) que se espera em função dele. Desvios podem ser facilmente identificados, tanto 
positivos (bom desempenho dos cultivos) quanto negativos (estresses durante o desenvolvimento dos cultivos). 
Outras informações climatológicas podem ser usadas para este propósito.  
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3.8. Conclusões 
Este exercício mostra a habilidade e o potencial de utilização dos dados difundidos via GEONETCast para o 
desenvolvimento de um sistema de monitoramento baseado em informações de satélite e locais. De forma análoga, 
esta informação pode ser amplamente explorada e os resultados podem ser aplicados a vários setores, fornecendo 
dados que podem ser usados para quantificar parâmetros bioclimáticos e monitorar a sua evolução no tempo e no 
espaço, assim constituindo uma importante fonte de informação. 
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